You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com

Copyright © 2012, 2013 VMware, Inc. All rights reserved. This product is protected by U.S. and international copyright and intellectual property laws. VMware products are covered by one or more patents listed at http://www.vmware.com/go/patents.

VMware is a registered trademark or trademark of VMware, Inc. in the United States and other jurisdictions. All other marks and names mentioned herein may be trademarks of their respective companies.
# Contents

vCenter Infrastructure Navigator Installation and Configuration Guide  5

1  vCenter Infrastructure Navigator Overview  7  
   vCenter Infrastructure Navigator Functionality  7  
   vCenter Infrastructure Navigator Target Users and Benefits  8  
   vCenter Infrastructure Navigator Architecture  8  
   Components of vCenter Infrastructure Navigator  9  

2  Installing vCenter Infrastructure Navigator  11  
   Register vCenter Server 5.1U1 System with the vSphere Web Client 5.5  11  
   Register vCenter Server with the vSphere Web Client from the Command-line  12  
   Virtual Machine Requirements  13  
   ESX/ESXi Requirements for vCenter Infrastructure Navigator  13  
   Software Requirements for vCenter Infrastructure Navigator  14  
   vCenter Infrastructure Navigator Port Requirements  15  
   Deploy a vCenter Infrastructure Navigator Virtual Appliance Using the vSphere Web Client  15  
   Deploy a vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Client  16  
   Using Single Sign-On with vSphere  18  

3  Setting Up vCenter Infrastructure Navigator  19  
   vCenter Infrastructure Navigator Licensing  19  
   Privileges Required for vCenter Infrastructure Navigator  21  
   Select vCenter Server  24  
   View System Information  24  
   Managing Application Discovery  25  
   Update vCenter Credentials  26  
   Integrating vCenter Site Recovery Manager with vCenter Infrastructure Navigator  26  
   Update vCenter Site Recovery Manager Administrator Credentials  27  
   Creating Product Support Package  27  
   Upgrading vCenter Infrastructure Navigator Knowledge Base  27  
   vCenter Infrastructure Navigator Log Files  28  

4  Security Overview  29  
   Firewall for vCenter Infrastructure Navigator  29  
   Protecting Sensitive Files  30  
   Securing vCenter Infrastructure Navigator  30  

5  Upgrading vCenter Infrastructure Navigator  33  
   Upgrading vCenter Infrastructure Navigator  33  
   Upgrade vCenter Infrastructure Navigator Using the Web Console  34  
   Upgrade Limitations for vCenter Infrastructure Navigator  34  

VMware, Inc.
6 Uninstalling vCenter Infrastructure Navigator  35
   Uninstall vCenter Infrastructure Navigator Plug-in  35

7 Troubleshooting vCenter Infrastructure Navigator  37
   vCenter Certificate Error  37
   vCenter Infrastructure Navigator Plug-In is not Visible in vSphere Web Client After an Upgrade  38
   Error in Retrieving Information Might Occur  38
   Incorrect Marking of a Virtual Machine as an External Machine  38
   Deployment Failure After IP Address Change  39
   Failure of the Virtual Appliance After DHCP Selection  39
   VMware Tools Compatibility Error  39
   vCenter Infrastructure Navigator Authentication Failure  39
   Navigation Problem Between Objects  40
   Navigation Error  40
   Error Message in Recent Tasks List  40
   vCenter Infrastructure Navigator Plug-in Removal Failure  41

Index  43
vCenter Infrastructure Navigator Installation and Configuration Guide

The VMware vCenter Infrastructure Navigator Installation and Configuration Guide provides information about installing and configuring VMware® vCenter™ Infrastructure Navigator™.

vCenter Infrastructure Navigator is an application awareness plug-in to the vCenter Server that provides continuous dependency mapping of applications.

Intended Audience

This information is intended for virtual infrastructure administrators who are familiar with virtual machine technology and data center operations.
vCenter Infrastructure Navigator is an application awareness plug-in to the vCenter Server that provides continuous dependency mapping of applications.

vCenter Infrastructure Navigator offers application context to the virtual infrastructure administrators to monitor and manage the virtual infrastructure inventory objects and actions. Administrators can use vCenter Infrastructure Navigator to understand the impact of the change on the virtual environment in their application infrastructure.

**NOTE** Plug-ins (also referred to as Extensions) expand the capabilities of vCenter Server by adding features and functionality to the base product.

This chapter includes the following topics:

- “vCenter Infrastructure Navigator Functionality,” on page 7
- “vCenter Infrastructure Navigator Target Users and Benefits,” on page 8
- “vCenter Infrastructure Navigator Architecture,” on page 8
- “Components of vCenter Infrastructure Navigator,” on page 9

### vCenter Infrastructure Navigator Functionality

vCenter Infrastructure Navigator provides a centralized view of your application environment.

vCenter Infrastructure Navigator performs the following high-level functions:

- Maps virtual infrastructure resources such as virtual machines, Web servers, mail servers, database servers, application servers, cache servers, messaging servers, application management servers, and virtualization management servers.
- Displays relationships between virtual machines and external machines through services.
- Allows you to detect inconsistencies from the norm.
- Allows you to take advantage of integration with other VMware products such as vCenter Server, VMware vCenter Site Recovery Manager (SRM), and vCenter Operations Manager.
- Allows you to define multi-tier application pattern and then discovers all of this pattern instances in the vCenter Server. You can then view these application instance maps.
- Allows you to create or define manual applications that in turn allow you to track a group of virtual machines.
- Allows you to create or define roles that you can use to find instances of the applications in your environment.
vCenter Infrastructure Navigator Target Users and Benefits

vCenter Infrastructure Navigator creates a detailed model of the application environment and offers application context to its users.

vCenter Infrastructure Navigator helps virtual infrastructure administrators to accurately answer the following questions:

- Which application services are running on my virtual machines?
- What are the dependencies among application services running on different virtual machines?
- Where are the hidden optimization opportunities and how can I capitalize on them?
- How do certain application changes impact my environment?
- What are the risks involved in making changes in the virtual environment?
- How do certain virtual machine's issues impact application operation and how can I prevent or solve these issues?
- How the integration with SRM and vCenter Operations Manager benefits the users?

vCenter Infrastructure Navigator Architecture

vCenter Infrastructure Navigator is a virtual appliance that you can deploy on the vCenter Server. A virtual appliance is a virtual machine image that contains software designed to run in a virtual machine.

With the components of vCenter Infrastructure Navigator, you can map services running in your virtual environment, examine the application discovery status, view and analyze the dependency map, and have a centralized view of the entire application environment.

The architecture illustrates various components of vCenter Infrastructure Navigator and their dependencies.

Figure 1-1. vCenter Infrastructure Navigator Architecture Diagram
Components of vCenter Infrastructure Navigator

A component is a software or software design with a well-defined interface. A component represents specific behavior of the system.

The following table lists and describes principal components of vCenter Infrastructure Navigator.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server in vCenter Infrastructure Navigator virtual machine</td>
<td>The Server component reconciles the data from Active Discovery and transfers the data to the Database component.</td>
</tr>
<tr>
<td>Database in vCenter Infrastructure Navigator virtual machine</td>
<td>The Database component stores the data received from the Server component. The Database component also stores vCenter Infrastructure Navigator configurations. <strong>Note</strong> vCenter Infrastructure Navigator does not support storing of data in an external database.</td>
</tr>
<tr>
<td>vCenter Infrastructure Navigator Plug-In in the vSphere Web Client</td>
<td>The vCenter Infrastructure Navigator Plug-In in the vSphere Web Client provides a graphical user interface that you use to view and analyze dependencies.</td>
</tr>
<tr>
<td>Inventory Service</td>
<td>Inventory service is a vSphere component to which vCenter Infrastructure Navigator exports its data.</td>
</tr>
</tbody>
</table>
Installing
vCenter Infrastructure Navigator

vCenter Infrastructure Navigator is a virtual appliance that runs in a VMware virtual infrastructure. You must ensure that your environment meets requirements so that you can deploy and use the vCenter Infrastructure Navigator virtual appliance.

This chapter includes the following topics:

- “Register vCenter Server 5.1U1 System with the vSphere Web Client 5.5,” on page 11
- “Register vCenter Server with the vSphere Web Client from the Command-line,” on page 12
- “Virtual Machine Requirements,” on page 13
- “ESX/ESXi Requirements for vCenter Infrastructure Navigator,” on page 13
- “Software Requirements for vCenter Infrastructure Navigator,” on page 14
- “vCenter Infrastructure Navigator Port Requirements,” on page 15
- “Deploy an vCenter Infrastructure Navigator Virtual Appliance Using the vSphere Web Client,” on page 15
- “Deploy a vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Client,” on page 16
- “Using Single Sign-On with vSphere,” on page 18

Register vCenter Server 5.1U1 System with the vSphere Web Client 5.5

To enable connectivity to a vCenter Server 5.1U1 system with the vSphere Web Client 5.5, you need to register it with the vSphere Web Client using the vSphere Web Client Administration Tool.

The vSphere Web Client is a Web application that can reside either on the same system as vCenter Server or a separate system. Before you can connect to a vCenter Server 5.1U1 system with the vSphere Web Client, you must register the vCenter Server 5.1U1 system with the vSphere Web Client. Unregister a vCenter Server system when you no longer want users to be able to access it using a particular instance of the vSphere Web Client.

You do not need to register vCenter Server 5.5 systems that use the same vCenter Single Sign On server as the vSphere Web Client. The vSphere Web Client can locate such vCenter Server systems by using VMware Lookup Service.

vSphere Web Client does not support vCenter Server systems prior to 5.0.

- You can register multiple vCenter Server systems with a single vSphere Web Client.
- Register a given vCenter Server system with only one vSphere Web Client instance, rather than using multiple vSphere Web Client instances to manage that vCenter Server system.
Prerequisites

- Log in to the system on which the vSphere Web Client is installed. You cannot register a vCenter Server system with the client from a remote system.
- Ensure that you have login credentials with administrator privileges for the vCenter Server system that you are registering.
- If you want to use the server IP address to access the vSphere Web Client and your browser uses a proxy, add the server IP address to the list of proxy exceptions.

Procedure

1. Open a Web browser and go to either of the following URLs.

   Note: Use the localhost or loopback address instead of the server IP address if you want to access the administration tool.

   - https://localhost:9443/admin-app
   - https://127.0.0.1:9443/admin-app

   The vSphere Web Client Administration Tool appears.

2. Click Register vCenter Server.

3. In the vCenter Server URL text box, type the server name or IP address of the vCenter Server system. Do not include http:// or https://.

4. Type the user name and password for the vCenter Server system.

5. In the vSphere Web Client server name or IP field, enter the IP address or host name of the machine where the vSphere Web Client is installed. For example, hostname.example.com or 10.111.123.xx.

   Note: Do not use the localhost URL for the vSphere Web Client. If you enter the localhost URL, the license reporting functionality will not be available in the vSphere Web Client, unless the vSphere Web Client and vCenter Server are installed on the same system.

6. Click Register.

You can now use this instance of the client to log in to the vCenter Server system. In the Web browser, open https://client-hostname:port/vsphere-client/ to access the vSphere Web Client and log in to the client, where client-hostname is the host name or IP address of the machine where vSphere Web Client is installed and port is the port used by vSphere Web Client. For more information, see the vCenter Server and Host Management Guide.

Register vCenter Server with the vSphere Web Client from the Command-line

If you are using the vCenter Server appliance, you must register a vCenter Server 5.1U1 system with the vSphere Web Client from the command-line.

Because the admin-app user interface is not available on the vCenter Server appliance, you register a vCenter Server system with the vSphere Web Client from the command-line, using admin-cmd.sh.
Procedure

◆ Type the following command on the vCenter Server appliance:

```
/usr/lib/vmware-vsphere-client/scripts/admin-cmd.sh register
https://<WebClient_IPorHostName>:<WebClient_HttpsPort>/vsphere-client <VC_IP> <VC_Admin-User> <VC_Admin-Passwd>
```

Example: Passwords with Special Characters

If you use any special characters for the administrator password, you must enclose the password in single quotes.

```
```

Virtual Machine Requirements

You must meet certain requirements before you deploy the vCenter Infrastructure Navigator virtual appliance on the vSphere Client and vSphere Web Client.

<p>| Table 2-1. Virtual Machine Requirements |</p>
<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2 vCPU</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB</td>
</tr>
<tr>
<td>Disk size</td>
<td>24 GB</td>
</tr>
<tr>
<td>Network</td>
<td>1 Gbps</td>
</tr>
</tbody>
</table>

Additionally, you also need vCenter Infrastructure Navigator OVA to be deployed on the vCenter Server and predefined static IP pool on desired port groups.

ESX/ESXi Requirements for vCenter Infrastructure Navigator

vCenter Infrastructure Navigator supports all builds of ESXi version 5.x U1. Earlier versions are also supported, as described in the table.

Table 2-2. Supported ESX/ESXi versions

<table>
<thead>
<tr>
<th>Server</th>
<th>ESX (ServerPkg)</th>
<th>ESXi (VMvisorPkg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1.0 P03</td>
<td>433742, 449664, 477600, 477631, 502847, 502854, 502855, 538074, 604481, 702190, 725378, 988599</td>
<td>433803, 449808, 502847, 502854, 502855, 582847, 604481, 702190, 725378, 988599</td>
</tr>
<tr>
<td>4.0.0 U3</td>
<td>398348, 403554, 480973, 480974, 504849, 504850, 538074, 538075, 560580, 702116, 702117, 721907, 721909, 729614, 729617, 989175</td>
<td>398348, 403554, 480973, 480974, 504849, 504850, 538074, 538075, 560580, 702116, 702117, 721907, 721909, 729614, 729617, 989175</td>
</tr>
<tr>
<td>3.5 P25</td>
<td>391406, 437453, 604481, 702121, 725378, 988599</td>
<td>391406, 437453, 604481, 702121, 725378, 988599</td>
</tr>
</tbody>
</table>

Software Requirements for vCenter Infrastructure Navigator

You must meet certain software requirements to deploy a vCenter Infrastructure Navigator virtual appliance.

Table 2-3. Software Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Infrastructure 5.1U and 5.5</td>
<td>vCenter Server 5.1U1 update 1 and vCenter Server 5.5. The user interface of the vCenter Infrastructure Navigator 5.7 virtual appliance that is deployed on vCenter Server 5.1U1 can only be viewed from vSphere Web Client 5.5. <strong>Note</strong> In you are using the vCenter Server 5.1U1 version, then, in addition to the vSphere 5.5 Web Client, you must deploy vCenter Single Sign-On (SSO). For more information about vcenter Single Sign-On, see “Using Single Sign-On with vSphere,” on page 18.</td>
</tr>
<tr>
<td>vSphere Web Client</td>
<td>vSphere Web Client 5.5. To enable connectivity to a vCenter Server 5.1U1 system with vSphere Web Client 5.5, you must register it with the vSphere Web Client using the vSphere Web Client Administration Tool. For more information about how to register vCenter Server 5.1U1 system with the vSphere 5.5 Web Client, see “Register vCenter Server 5.1U1 System with the vSphere Web Client 5.5,” on page 11.</td>
</tr>
<tr>
<td>Virtual Center</td>
<td>Virtual Center IP address and administrator credentials.</td>
</tr>
<tr>
<td>Web browser</td>
<td>Microsoft Internet Explorer 7, 8, and 9, Google Chrome 14 or later, or Firefox 3.6 or later version. <strong>Note</strong> vSphere Web Client 5.1 requires Adobe Flash Player 11.1.0 or later to be installed in your browser.</td>
</tr>
<tr>
<td>Remote desktop</td>
<td>Remote desktop access to the Virtual Center with installed Web browser.</td>
</tr>
</tbody>
</table>
vCenter Infrastructure Navigator Port Requirements

vCenter Infrastructure Navigator requires certain TCP ports to be open for access.

Table 2-4. Port Requirements

<table>
<thead>
<tr>
<th>Port number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5480</td>
<td>For appliance Web console</td>
</tr>
<tr>
<td>5489</td>
<td>To communicate with VMware Update Manager (VUM). <strong>Note</strong>: This port is only used in the environment where VUM is installed.</td>
</tr>
<tr>
<td>22</td>
<td>To enable SSH access to the vCenter Infrastructure Navigator virtual appliance.</td>
</tr>
<tr>
<td>2868</td>
<td>For plug-in download. This download happens as part of the registration process.</td>
</tr>
<tr>
<td>6969</td>
<td>For connectivity from vSphere Web Client to vCenter Infrastructure Navigator.</td>
</tr>
<tr>
<td>443</td>
<td>To access vSphere Web service API.</td>
</tr>
<tr>
<td>80</td>
<td>To access vSphere Web service API.</td>
</tr>
<tr>
<td>10109</td>
<td>To access vSphere Inventory Service.</td>
</tr>
<tr>
<td>443</td>
<td>For VIX protocol on target hosts to perform discovery.</td>
</tr>
<tr>
<td>902</td>
<td>For VIX protocol on target hosts to perform discovery.</td>
</tr>
</tbody>
</table>

Deploy an vCenter Infrastructure Navigator Virtual Appliance Using the vSphere Web Client

You deploy the vCenter Infrastructure Navigator virtual appliance using vSphere Web Client. VMware provides the appliance in OVA format. In your environment, if multiple vCenter Servers are registered by Single Sign On (SSO) to the same vSphere Web Client, you must deploy a separate instance of vCenter Infrastructure Navigator for each vCenter Server.

**Prerequisites**

- Log in to the vSphere Web Client as a user with administrator privileges.
- Ensure that the virtual machine meets all requirements described in “Virtual Machine Requirements,” on page 13.
- Configure vCenter Managed IP address so that the vCenter Infrastructure Navigator virtual appliance can access the vCenter Server.
- Download the vCenter Infrastructure Navigator virtual appliance files from the VMware Web site.
- Install Client Integration Plug-in 5.1.0 on the system on which you are deploying the OVF template.

**Procedure**

1. In the vSphere Web Client, click **Host and Clusters**.
2 Right-click the vCenter Server on which you are deploying vCenter Infrastructure Navigator and select **Deploy OVF template**.

3 Browse to the OVA file and select it, or enter the URL from where you want to deploy the OVA template, and click **Next**.

4 In the Review details screen, click **Next**.

5 Accept the End User License Agreement and click **Next**.

6 On the Select name and folder screen, type a unique virtual appliance name according to the IT naming convention of your organization.

7 Select the folder or data center where you want to deploy the OVF, and click **Next**.
   
    If more than one data center is present, select the data center on which you want to deploy the virtual appliance.

8 On the Select a resource screen, select the location to run the deployed OVF template, and click **Next**.
   
    The Select storage screen appears where you can select the location to store the files of the deployed OVF template.

9 From the **Select virtual disk format** drop-down menu, select **Thin Provision** as the disk format, and click **Next**.

10 Configure the networks for the deployed template to use, and click **Next**.

11 Type and confirm the administrative password for the root account.

12 Leave the **Default Gateway**, **DNS**, **Network 1 IP Address**, and **Network 1 Netmask** parameters blank if you want to acquire these values from a DHCP server, and click **Next**.

   The vService Bindings screen appears.

13 If you have configured the vCenter Managed IP address, proceed with deployment, and click **Next**.

   A Ready to Complete screen displays a summary of the deployment settings.

14 Select **Power on after deployment**, and then click **Finish**.

   The process of deploying the vCenter Infrastructure Navigator virtual appliance starts.

The process of deploying the vCenter Infrastructure Navigator virtual appliance might take several minutes. After the process is complete, the vCenter Infrastructure Navigator OVA is deployed on your vSphere Web Client. Log out of the vSphere Web Client and log in again.

**What to do next**

Specify a valid license and start the discovery process. See “vCenter Infrastructure Navigator Licensing,” on page 19.

**Deploy a vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Client**

You can use the vSphere Client user interface to deploy the vCenter Infrastructure Navigator virtual appliance. VMware provides the appliance in an OVA format. If multiple vCenter servers are registered through the same SSO, you need to deploy vCenter Infrastructure Navigator on all the vCenter servers.

**Prerequisites**

- Log in to the vSphere Client as a user with administrator privileges.

- Ensure that the virtual machine meets all requirements as described in “Virtual Machine Requirements,” on page 13 section.
Configure vCenter Managed IP address so that the vCenter Infrastructure Navigator virtual appliance can access the vCenter Server. To configure vCenter Managed IP address in the vSphere Client, navigate to Administration > vCenter Server Settings > Runtime Settings and enter the IP address of the vCenter Server in vCenter Server Managed IP field.

- Download the vCenter Infrastructure Navigator virtual appliance files from VMware Web site.
- Install Client Integration Plug-in 5.5 on the system on which you are deploying the OVF template.

**Procedure**

1. In the vSphere Client, navigate to File > Deploy OVF Template.
2. Browse to the OVA file and select it and click Next.
3. In the OVF Template Details screen, Click Next and accept End User License Agreement and then click Next.
4. In the Name and Location screen, type a unique virtual appliance name according to the IT naming convention of your organization, and click Next.
   - If more than one Datacenter is present, you must select the Datacenter on which you want to deploy the virtual appliance.
5. If the Host/Cluster screen appears, select the host or cluster where you want to deploy the virtual appliance, and click Next.
6. If the Resource Pool screen appears, select the resource pool within which you want deploy the virtual appliance, and click Next.
7. In the Disk Format screen, select Thin Provision as the disk format, and click Next.
   - The Network Mapping screen appears.
8. Select a network for the OVA, and click Next.
   - The Properties screen appears.
9. Enter the administrative password for the root account in the Enter password field and enter the same password in Confirm password field.
10. Leave the Default Gateway, DNS, Network 1 IP Address, and Network 1 Netmask parameters blank if you want to acquire these values from DHCP server. You can also configure static IP addresses manually. Click Next.
    - The Configure Service Bindings screen appears.
11. If you have configured the vCenter Managed IP address, you can proceed ahead with deployment and click Next.
    - The Ready to Complete screen displays a summary of the deployment settings.
12. Select Power on after deployment, and then click Finish to confirm the settings and begin the deployment.

The process of deploying the vCenter Infrastructure Navigator virtual appliance starts.

The process of deploying the vCenter Infrastructure Navigator virtual appliance might take several minutes. After the process is complete, the vCenter Infrastructure Navigator OVA is deployed on your vSphere Client. Also, the vCenter Infrastructure Navigator is preparing the environment for discovery message appears in the Tasks & Events tab of the vSphere Client. If you are logged in to the vSphere Web Client, log out and log in again.
What to do next

You must now enter a valid license and start the discovery process. For more information about licensing and starting of the discovery process, see Chapter 3, “Setting Up vCenter Infrastructure Navigator,” on page 19.

Using Single Sign-On with vSphere

You use VMware® vCenter™ Single Sign-On authenticate and manage vCenter Server users.

In vCenter Server versions earlier than vCenter Server 5.1, when a user connects to vCenter Server, vCenter Server authenticates the user by validating the user against an Active Directory domain or the list of local operating system users. In vCenter Server 5.1, users authenticate through vCenter Single Sign-On.

The Single Sign-On administrative interface is part of the vSphere Web Client. To configure Single Sign-On and manage Single Sign-On users and groups, you log in to the vSphere Web Client as a user with Single Sign-On administrator privileges. This might not be the same user as the vCenter Server administrator. Enter the credentials on the vSphere Web Client login page and upon authentication, you can access the Single Sign-On administration tool to create users and assign administrative permissions to other users.

vSphere 5.1 users have the option of logging in to vCenter Server with the vSphere Client or with the vSphere Web Client.

- Using the vSphere Client, you log in to each vCenter Server system separately. All linked vCenter Server instances are visible on the left pane of the vSphere Client. The vSphere Client does not show vCenter Server systems that are not linked to the vCenter Server that the user logged in to unless the user connects to those vCenter Server systems explicitly. This behavior is unchanged from vCenter Server versions earlier than version 5.1.

- Using the vSphere Web Client, you authenticate to Single Sign-On by entering your credentials on the vSphere Web Client login page. You can then view all of the vCenter Server instances for which you have permissions. After you connect to vCenter Server, no further authentication is required. The actions that you can perform on objects depend on the user’s vCenter Server permissions on those objects.

For versions earlier than vCenter Server 5.1, you must explicitly register each vCenter Server system with the vSphere Web Client. For vCenter Server 5.1, vCenter Server systems are automatically detected and are displayed in the vSphere Web Client inventory. For more information about configuring Single Sign-On, see http://pubs.vmware.com/vsphere-51/index.jsp.
After you deploy a vCenter Infrastructure Navigator virtual appliance you must enter a valid license for the vCenter Infrastructure Navigator. After you enter a valid license, you can start the application discovery process, set the vCenter Server credentials, and integrate vCenter Site Recovery Manager. You can also obtain the system information and product logs information.

This chapter includes the following topics:

- “vCenter Infrastructure Navigator Licensing,” on page 19
- “Privileges Required for vCenter Infrastructure Navigator,” on page 21
- “Select vCenter Server,” on page 24
- “View System Information,” on page 24
- “Managing Application Discovery,” on page 25
- “Update vCenter Credentials,” on page 26
- “Integrating vCenter Site Recovery Manager with vCenter Infrastructure Navigator,” on page 26
- “Update vCenter Site Recovery Manager Administrator Credentials,” on page 27
- “Creating Product Support Package,” on page 27
- “Upgrading vCenter Infrastructure Navigator Knowledge Base,” on page 27
- “vCenter Infrastructure Navigator Log Files,” on page 28

vCenter Infrastructure Navigator Licensing

If you deploy the vCenter Infrastructure Navigator virtual appliance on the vCenter Server, the virtual appliance is deployed without a license key. As a result, application discovery is disabled. You must enter a valid license key to start the application discovery process.

After you enter a valid license key, the vCenter Infrastructure Navigator monitors the number of virtual machines discovered by vCenter Infrastructure Navigator with regards to the number of virtual machines allowed. You can acquire a license depending on the number of virtual machines and applications running in your environment.

vCenter Infrastructure Navigator supports suite licenses for vCenter Server 5.1 and standalone licenses for vCenter Server 5.0. Table 3-1 lists the vCenter Server versions and its supported licenses for the vCenter Infrastructure Navigator.
Table 3-1. Supported Licenses

<table>
<thead>
<tr>
<th>vCenter Server Version</th>
<th>Supported Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCenter Server 5.1</td>
<td>vCenter Operations Manager Suite 5.6 or later, and VMware vCloud Advanced and Enterprise Suite 5.1 or later.</td>
</tr>
<tr>
<td>vCenter Server 5.0</td>
<td>Only vCenter Infrastructure Navigator 2.x Standalone.</td>
</tr>
</tbody>
</table>

Licensing in Single Sign On Mode

In single sign on mode, you must deploy a separate instance of vCenter Infrastructure Navigator for each vCenter Server. To enable the discovery process, you must enter a license key for all the instances of vCenter Infrastructure Navigator under the licensing section of vSphere Web Client.

**Note** For each vCenter Infrastructure Navigator virtual appliance installed on vCenter Server 5.0 that is registered to the vSphere 5.1 Web Client, you need to follow the same process.

Apply vCenter Infrastructure Navigator License by Using vSphere Web Client

The vCenter Infrastructure Navigator virtual appliance is deployed without a license key. You can apply the license key by using vSphere Web Client to start the application discovery process.

**Prerequisites**

Deploy the vCenter Infrastructure Navigator virtual appliance on the vCenter Server.

**Procedure**

1. Log in to the vSphere Web Client as an administrator.
2. Navigate to Administration > Licensing >Licenses.
3. From the vCenter Server drop-down menu, select the vCenter Server instance where vCenter Infrastructure Navigator is deployed.
4. Click the Solutions tab and select the vCenter Infrastructure Navigator virtual appliance for which you want to assign the license.
5. Click the Assign License Key icon.
6. From the licensing method drop-down menu, select Assign a new license key.
7. Type the license key, and type an optional label for the key.
8. Click OK.

The license key is applied for the vCenter Infrastructure Navigator virtual appliance. You can now start the discovery process.

Apply a vCenter Infrastructure Navigator License

The vCenter Infrastructure Navigator virtual appliance is deployed without a license key. You must apply the license key to start the application discovery process.

**Prerequisites**

Deploy the vCenter Infrastructure Navigator virtual appliance on the vCenter Server.
Procedure

1. Log in to the vSphere Client as an administrator.
2. Navigate to View > Administration > Licensing.
3. Select the Asset check box.
   The vCenter Infrastructure Navigator virtual appliance is listed.
4. Double-click the vCenter Infrastructure Navigator virtual appliance.
5. Select the Assign a new license key to this solution check box.
6. Click Enter Key.
7. Type a valid license key and an optional label for the new license key and click OK.
   The license key is displayed.
8. Click OK.

The license key is applied for the vCenter Infrastructure Navigator virtual appliance. You can now start the discovery process.

Evaluation License for vCenter Infrastructure Navigator

The evaluation license of vCenter Infrastructure Navigator is time-based and is preset to expire in 30 days. If you apply an evaluation license for vCenter Infrastructure Navigator, every time you log in to the vSphere client and vSphere Web Client, an alert warning with the number of days left for the license to expire is displayed.

You can apply an evaluation license by using the vSphere Client as described in “Apply a vCenter Infrastructure Navigator License,” on page 20. After you apply an evaluation license, the Start Discovery button in vSphere Web Client is enabled, but the discovery is not started, and a message that asks you to apply a license no longer appears. If an evaluation license expires and you have not disabled or uninstalled vCenter Infrastructure Navigator, an alert warning that the license has expired is displayed. However, even after the license expires, the vCenter Infrastructure Navigator plug-in is not disabled. The discovery process is not affected by expiration of the license and you can still view and manage the information presented by vCenter Infrastructure Navigator.

Privileges Required for vCenter Infrastructure Navigator

You must log in to vSphere Web Client as an administrator to use the services offered by vCenter Infrastructure Navigator.

An administrator is a user who is assigned the administrator role on the vCenter Server or a user in a group that is assigned the administrators role on the vCenter Server. A user or group must be assigned the administrator role on the root folder and all the child objects that propagate from the root folder.

Assign Administrator Privileges by Using vSphere Web Client

You can assign administrator privileges to a user or group on the root folder and all the child objects that are propagating from the root folder by using vSphere Web Client.

Procedure

1. Log in to the vSphere Web Client as an administrator.
2. At the vCenter entity level, click the Manage tab and select Permissions.
3. Click Add Permission.
4 Select Administrator from the Assigned Role drop-down menu.
   This drop-down menu displays all the roles that are assigned to the object. When the role appears, the
   privileges contained in the role are listed in the section below the role title.

5 Select Propagate to children of the vCenter Server name virtual machine.

6 Click Add.

7 From the Domain drop-down menu, select the domain where the user or group is located.

8 Type a name in the Search box or select a name from the Name list, and click Add.
   The name is added to the Users or Groups list.

9 Repeat Step 7 and Step 8 to add additional users or groups.

10 Click OK.

11 To finish the task, click OK.

   The server adds administrator privileges to the user.

Assign Administrator Privileges by Using vSphere Web Client

To view services offered by vCenter Infrastructure Navigator when you log in to vSphere Web Client, you
must assign administrative privileges to the user or group on the root folder and all the child objects that are
propagating from the root folder in vSphere Web Client.

Procedure

1 Log in to the vSphere Web Client.

2 On the vCenter entity root level, right-click and select Add Permission.

3 In the Assign Permissions window, select Administrator from the Assigned Role drop-down menu.
   The privileges contained in the role are listed in the section below the role title.

4 Select Propagate to Child Objects.

5 Click Add.
   The appears.

6 In the Select Users and Groups window, select the domain where the user or group is located from the Domain drop-down menu.

7 Type a name in the Search box or select a name from the Name list.

8 Click Add.
   The name is added to the Users or Groups list.

9 Repeat steps Step 6 through Step 8 to add additional users or groups.

10 Click OK.

11 To finish the task, click OK.

   The server adds administrator privileges to the user.
Minimal Privileges for Discovery

To accommodate security needs vCenter Infrastructure Navigator supports some minimally-privileged users. These users cannot log in into the vSphere Web Client, but their credentials can be used to enable the discovery process.

vCenter Infrastructure Navigator requires that users have administrative privileges. For more information, see “Privileges Required for vCenter Infrastructure Navigator,” on page 21. However, to accommodate security needs, vCenter Infrastructure Navigator also supports some minimally-privileged users for enabling discovery. For more information, see “Creating a Role with Minimal Privileges to Enable Discovery by Using the vSphere Web Client,” on page 23.

Creating a Role with Minimal Privileges to Enable Discovery Using vSphere Web Client

You can create a role with Guest operating system management by VIX API and Console interaction privileges. After you create a role, you must assign a user to this role on the entire data center by assigning the user to the root folder and all the child objects that are propagating from the root folder in the vSphere Web Client.

Procedure

1. Log in to the vSphere Web Client as an administrator.
2. From the Inventory menu, navigate to Administration > Role Manager.
   The Roles screen appears.
3. Click Create role action icon.
5. Select Guest operating system management by VIX API and Console interaction check boxes.
6. Type a name in the Role name text box.
7. Click OK.

A role is created with Guest operating system management by VIX API and Console interaction privileges. You can now go ahead and assign a user to this role by selecting this role as a role in “Assign Administrator Privileges by Using vSphere Web Client,” on page 22 procedure. After the completion of the procedure, the user has required privileges to enable the discovery process.

Creating a Role with Minimal Privileges to Enable Discovery by Using the vSphere Web Client

You can create a role with Guest operating system management by VIX API and Console interaction privileges. After you create a role, you must assign a user to this role on the entire datacenter by assigning the user to the root folder and all the child objects that are propagating from the root folder in vSphere Web Client.

Procedure

1. Log in to the vSphere Web Client as an administrator.
2. From the View menu, navigate to Administration > Roles.
   The Roles screen appears.
3. Click Add Role.
   The Add New Role window appears.
5. Select Guest operating system management by VIX API and Console interaction check boxes.
6. Type a name in the Name text box.
7. Click OK.

A role is created with Guest operating system management by VIX API and console interaction privileges. You can now assign a user to this role by selecting the role as a role using the “Assign Administrator Privileges by Using vSphere Web Client,” on page 22 procedure. After completion of the procedure, the user has the necessary privileges to enable the discovery process.

Select vCenter Server

If you have multiple vCenter Server instances, you can select the vCenter Server to work with. vCenter Infrastructure Navigator updates the information pertaining to the selected vCenter Server.

Procedure

1. Log in to the vSphere Web Client as an administrator.
2. On the inventory menu, click Infrastructure Navigator.
3. Click the Settings tab.
4. From the vCenter Server drop-down menu, select the vCenter Server to work with.

The vCenter Infrastructure Navigator virtual appliance information for the selected vCenter Server is updated.

If vCenter Infrastructure Navigator is not installed on the selected vCenter Server, this message is displayed.

Infrastructure Navigator is not installed on this vCenter Server.
If you are working with multiple vCenter servers, select the vCenter Server where Infrastructure Navigator is installed.
If you want to uninstall Infrastructure Navigator, you must restart the vSphere Web Client service to complete the uninstall process. You can then delete the virtual appliance.

View System Information

The Settings tab displays the product version and knowledge base version of the vCenter Infrastructure Navigator virtual appliance. This page also displays the build number of the vCenter Infrastructure Navigator virtual appliance that you are currently using.

Procedure

1. Log in to the vSphere Web Client as an administrator.
2. From the inventory menu, click Infrastructure Navigator.
3. In the vCenter Infrastructure Navigator home page, click the Settings tab.

The system information page appears.
Managing Application Discovery

In the vSphere Web Client, the Settings tab provides the functionality to start and stop the application discovery process. You can start the application discovery process to retrieve information about the applications running in your environment.

Start Application Discovery

vCenter Infrastructure Navigator utilizes VMware tools to access virtual machines. Start the application discovery process to retrieve information about the applications running in your vCenter Server environment.

Prerequisites

- Verify that you have entered the license for the vCenter Infrastructure Navigator virtual appliance. For more information, see “vCenter Infrastructure Navigator Licensing,” on page 19.
- Verify that you have a user with the required privileges to start the discovery process. For more information, see “Privileges Required for vCenter Infrastructure Navigator,” on page 21.

Procedure

1. Log in to vSphere Web Client.
2. From the inventory menu, click Infrastructure Navigator.
3. In the vCenter Infrastructure Navigator home page, click the Settings tab.
4. Click Turn On Discovery.
5. Type the user name and password and click OK.

If you are starting the application discovery for the first time, you must provide the vCenter Server administrator credentials or the privileges described in “Minimal Privileges for Discovery,” on page 23. If the credentials are valid, vCenter Infrastructure Navigator starts the discovery of all the applications in your environment and the message Application Discovery is running is displayed.

Note: After the discovery starts, the vCenter Infrastructure Navigator is discovering message appears in the vSphere Web Client.

Stop Application Discovery

You can stop the application discovery process and to ensure all the discovery actions performed by vCenter Infrastructure Navigator are discontinued.

Procedure

1. Log in to the vSphere Web Client.
2. From the inventory menu, click Infrastructure Navigator.
3. In the vCenter Infrastructure Navigator home page, click the Settings tab.
4. Click Turn Off Discovery.

vCenter Infrastructure Navigator stops the application discovery process and the message Application Discovery is stopped appears.
Update vCenter Credentials

If you have changed or modified credentials of the administrator or minimally privileged user, you must update the credentials in the Settings tab of vCenter Infrastructure Navigator in the vSphere Web Client.

Procedure
1. Log in to vSphere Web Client.
2. From the inventory menu, click Infrastructure Navigator.
3. In the vCenter Infrastructure Navigator home page, click the Settings tab.
4. Click the [user: <user name>] link.
5. In the Enter vCenter administrator credentials window, type the user name and password and click OK.

vCenter Infrastructure Navigator updates the credentials successfully.

Integrating vCenter Site Recovery Manager with vCenter Infrastructure Navigator

The vCenter Site Recovery Manager integration with vCenter Infrastructure Navigator displays the vCenter Site Recovery Manager Protection Groups and vCenter Site Recovery Manager Recovery Plans of the selected virtual machine.

Start vCenter Site Recovery Manager Integration

Start the vCenter Site Recovery Manager integration to display the vCenter Site Recovery Manager information in the inventory table and dependency map.

Procedure
1. Log in to vSphere Web Client.
2. From the inventory menu, click Infrastructure Navigator.
   
   The vCenter Infrastructure Navigator home page appears.
3. Click the Settings tab.
4. Click Turn On Integration.
5. In the Enter vCenter Site Recovery Manager administrator credentials window type the user name and password and click OK.
   
   You must provide the vCenter Site Recovery Manager administrator credentials to start the integration for the first time.

   integration of vCenter Site Recovery Manager starts and the message Integration is on is displayed.

Stop vCenter Site Recovery Manager Server Integration

Stop SRM integration to remove all columns and indicators of SRM from the vCenter Infrastructure Navigator screen.

Procedure
1. Log in to vSphere Web Client.
2 From the inventory menu, click **Infrastructure Navigator**.
   The vCenter Infrastructure Navigator home page appears.
3 Click the **Settings** tab.
4 Click **Turn Off Integration**.
   vCenter Infrastructure Navigator stops SRM integration and the message **Integration is off** is displayed.

**Update vCenter Site Recovery Manager Administrator Credentials**

If you change vCenter Site Recovery Manager credentials, you must update the credentials on the **Settings** tab of the vCenter Infrastructure Navigator virtual appliance in the vSphere Web Client.

**Procedure**

1 Log in to vSphere Web Client.
2 From the inventory menu, click **Infrastructure Navigator**.
3 In the vCenter Infrastructure Navigator home page, click the **Settings** tab.
4 Click the **[user: <user name>]** link.
5 In the Enter Site Recovery Manager administrator credentials window, type the user name and password and click **OK**.
   vCenter Infrastructure Navigator updates the credentials successfully.

**Creating Product Support Package**

You can use the vCenter Infrastructure Navigator product support package to get system information and product logs information.

**Procedure**

1 Connect to the vCenter Infrastructure Navigator virtual machine using SSH.
2 Navigate to `/opt/vadm-engine/bin/` by running the command `cd /opt/vadm-engine/bin/`.
3 Create the product support package by running the command `/support_package.sh`.
   A `vadm_server_support_package_*.tgz` file is created and is stored in `/opt/vadm-engine/bin/` folder.

**Upgrading vCenter Infrastructure Navigator Knowledge Base**

You can update the vCenter Infrastructure Navigator knowledge base with new updates without installing a new vCenter Infrastructure Navigator virtual appliance.

**Prerequisites**

The new knowledge base JAR file must be present under the `/opt/vadm-activecollector/bin` directory.

**Procedure**

1 Connect to the vCenter Infrastructure Navigator virtual machine through SSH.
2 Navigate to `/opt/vadm-activecollector/bin` by running the command.
   `cd /opt/vadm-activecollector/bin`
3 Run the command.
   `./update_kb.sh new_knowledge_base_filename.jar`
The update procedure takes between one to two minutes to finish.

4 (Optional) You can verify the progress by running commands.

tail -f /var/log/vadm/engine.log, tail -f /var/log/vadm/activecollector.log, ll /opt/vadm-activecollector/lib, and ll /opt/vadm-activecollector/tmp

The vCenter Infrastructure Navigator knowledge base is updated.

**vCenter Infrastructure Navigator Log Files**

All vCenter Infrastructure Navigator log files are located in `/var/log/vadm/`. The following table lists all the generic log files that are available in vCenter Infrastructure Navigator.

<table>
<thead>
<tr>
<th>Filename</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activecollector.log</td>
<td>The active collector log file</td>
</tr>
<tr>
<td>dbconfig.log</td>
<td>The database operations log file</td>
</tr>
<tr>
<td>engine.log</td>
<td>The engine log file</td>
</tr>
<tr>
<td>engine.catalina.log</td>
<td>Internal tc Server log file</td>
</tr>
<tr>
<td>db/postgresql.log</td>
<td>PostgreSQL log file</td>
</tr>
<tr>
<td>kb-update.log</td>
<td>Logs knowledge base update</td>
</tr>
<tr>
<td>update.log</td>
<td>Logs the virtual appliance updates</td>
</tr>
</tbody>
</table>

The following table lists the service log files available in vCenter Infrastructure Navigator.

<table>
<thead>
<tr>
<th>Services Log</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activecollector.stdout</td>
<td>For the active collector services</td>
</tr>
<tr>
<td>listener.stdout</td>
<td>For the listener services</td>
</tr>
<tr>
<td>engine.catalina-out.log</td>
<td>For the engine services</td>
</tr>
</tbody>
</table>

The vSphere Web Client log file is located on the vSphere Web Client server at C:\ProgramData\VMware\vSphere Web Client\serviceability\logs\vsphere_client_virgo.txt.
vCenter Infrastructure Navigator offers strong network security to protect sensitive corporate data. The vCenter Infrastructure Navigator plug-in leverages the vCenter Server for authentication and eliminates the user management requirement.

vCenter Infrastructure Navigator uses PostgreSQL as the database and other individual process that are limited to a single virtual appliance. This limit reduces the vulnerability of the system by allowing the components to perform inter-process communication on the local protected channels.

This chapter includes the following topics:

- “Firewall for vCenter Infrastructure Navigator,” on page 29
- “Protecting Sensitive Files,” on page 30
- “Securing vCenter Infrastructure Navigator,” on page 30

**Firewall for vCenter Infrastructure Navigator**

vCenter Infrastructure Navigator uses the SLES, SuSEfirewall2 firewall. vCenter Infrastructure Navigator requires certain TCP ports to be open for proper operation of the product.

The firewall is configured so that vCenter Infrastructure Navigator can use the following ports.

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5480</td>
<td>For appliance Web console.</td>
</tr>
<tr>
<td>5489</td>
<td>To communicate with VMware Update Manager (VUM). <strong>Note</strong>: This port is only used in the environment where VUM is installed.</td>
</tr>
<tr>
<td>22</td>
<td>To enable SSH access to the vCenter Infrastructure Navigator virtual appliance.</td>
</tr>
<tr>
<td>80</td>
<td>To access vSphere Web service API.</td>
</tr>
<tr>
<td>2868</td>
<td>For plug-in download. This download happens as part of the registration process.</td>
</tr>
<tr>
<td>6969</td>
<td>For connectivity from vSphere Web Client to vCenter Infrastructure Navigator.</td>
</tr>
</tbody>
</table>

The firewall is started during the first boot of the operating system. To stop the firewall, monitor its status, or start the firewall, use the following commands.


Table 4-2. Commands for Firewall

<table>
<thead>
<tr>
<th>Operation</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>stop</td>
<td>/etc/init.d/SuSEfirewall2_setup stop</td>
</tr>
<tr>
<td>status</td>
<td>/etc/init.d/SuSEfirewall2_setup status</td>
</tr>
<tr>
<td>start</td>
<td>/etc/init.d/SuSEfirewall2_setup start</td>
</tr>
</tbody>
</table>

Protecting Sensitive Files

vCenter Infrastructure Navigator has some sensitive files that must be protected from unauthorised access as that might compromise vCenter Infrastructure Navigator security.

Critical Files

The vadm.keystore file, found under /opt/vadm-engine/conf/ is a critical file that contains private key and certificate of the application. Unauthorized access to this file might give an attacker access to the vCenter Infrastructure Navigator database.

The vadm.keystore file is protected by access controls. Do not change the permissions on the file or folder as it might either give too much access, reduce security, or restrict access, thereby preventing vCenter Infrastructure Navigator from working.

Limiting Access to Virtual Machines

For the access controls to work correctly, access to the vCenter Infrastructure Navigator virtual appliance must be strictly limited to those with a need to log in, with the minimal levels of access required. This involves limiting the use of the root account. Any backups of the vCenter Infrastructure Navigator virtual appliance must be strictly protected and encrypted with the keys managed separately from the backups.

It is possible for vCenter Infrastructure Navigator to access all machines in the vCenter Server environment using the Super User privilege. To avoid such access, under VIN Home > Settings, verify that the Access to VMs indicator shows that the access is off. The default is Off.

Securing vCenter Infrastructure Navigator

It is important that measures are taken to ensure that installation files are valid and that communication between the vCenter Infrastructure Navigator virtual appliance and the vSphere Web Client are secure.

Validating Installation Files

Before performing an installation or upgrade, it is good practice to validate the installation files to avoid middleman attacks.

Use SSH hashes to verify the files.

Verifying the Authenticity of the Server

vCenter Infrastructure Navigator uses digital certificates to enable secure communication between the vCenter Infrastructure Navigator virtual appliance and the vSphere Web Client, based on Transport Layer Security (TLS).
TLS is based on the Secure Sockets Layer (SSL) specifications developed by Netscape Communications and has been standardized by the Internet Engineering Task Force (IETF). TLS provides privacy of communication by using encryption and also allows you to verify the authenticity of the server with which you are communicating.

During the first boot of the appliance, a self-signed certificate is generated. This certificate is used for encrypted TLS communication.
You can upgrade a vCenter Infrastructure Navigator virtual appliance without the need to redeploy the virtual appliance. Such an upgrade applies to vCenter Infrastructure Navigator Red Hat Package Manager (RPM) and third-party RPMs such as RabbitMQ.

This chapter includes the following topics:

- “Upgrading vCenter Infrastructure Navigator,” on page 33
- “Upgrade vCenter Infrastructure Navigator Using the Web Console,” on page 34
- “Upgrade Limitations for vCenter Infrastructure Navigator,” on page 34

### Upgrading vCenter Infrastructure Navigator

vCenter Infrastructure Navigator 1.2 and later can be upgraded to the latest supported version using the vCenter Infrastructure Navigator Web console. You can use the Update tab in the vCenter Infrastructure Navigator Web console to upgrade the vCenter Infrastructure Navigator virtual appliance.

**Note** vCenter Infrastructure Navigator does not support upgrade through VMware Update Manager.

The Settings tab shows the policies that you can set to periodically check and install vCenter Infrastructure Navigator virtual appliance updates.

**Table 5-1. Update Policies**

<table>
<thead>
<tr>
<th>Update Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No automatic updates</td>
<td>This check box is selected by default. The virtual appliance does not check and install updates.</td>
</tr>
<tr>
<td>Automatic check for updates</td>
<td>The virtual appliance checks for updates at the scheduled time. If an update is available, it appears on the Update Status page.</td>
</tr>
<tr>
<td>Automatic check and install updates</td>
<td>The virtual appliance checks for updates at the scheduled time, and if updates are available, installs them.</td>
</tr>
</tbody>
</table>

If you select either **Automatic check for updates** or **Automatic check and install updates**, you can configure the scheduling. By default, the check occurs daily at 3:00 a.m. local time, as determined by your time zone setting.

By default, vCenter Infrastructure Navigator updates from the VMware vapp-updates Web site. You can choose instead to update from a CD-ROM or from an alternative update repository URL.
If you upgrade from version 1.2 to version 2.0, discovery stops and the Discovery is off message is displayed in the vSphere Web Client. If you try to start the discovery from the Settings tab, a message that asks you to assign a new license appears. You must assign a new version 2.x license to start the discovery process, because you cannot assign a version 1.2 license to vCenter Infrastructure Navigator 2.0s.

Upgrade vCenter Infrastructure Navigator Using the Web Console

You can upgrade the vCenter Infrastructure Navigator virtual appliance by using the vCenter Infrastructure Navigator Web console. The upgrade procedure performs all the operations required to upgrade the vCenter Infrastructure Navigator virtual appliance.

Prerequisites

Verify that you have a snapshot of the vCenter Infrastructure Navigator virtual appliance before you run the upgrade procedure. If a problem occurs with the virtual appliance after the upgrade, you can revert to the snapshot.

Procedure

1. Log in to the vCenter Infrastructure Navigator Web console.
2. Click the Update tab.
   The current status of vCenter Infrastructure Navigator virtual appliance is displayed.
3. Click Check Updates.
   The available updates are listed.
4. Click Install Updates.
   A message confirms that the update is in progress.

After the update is complete, the Status tab displays data about the update under Last Check and Last Update.

What to do next

Restart the vSphere Web Client service on the vCenter Server after you perform the update procedure.

Upgrade Limitations for vCenter Infrastructure Navigator

Some limitations are associated with the upgrade of the vCenter Infrastructure Navigator virtual appliance. Consider these limitations before upgrading the virtual appliance.

- You cannot roll back to an earlier version after you perform the upgrade procedure. Take a snapshot of the vCenter Infrastructure Navigator virtual appliance before you run the upgrade procedure.
- When using the vCenter Infrastructure Navigator Web console, you can only upgrade to the latest version available.
- No authentication or access control mechanism is available to the catalog.
- During the upgrade procedure, if you try to access the Application Dependencies tab in the vSphere Web Client, you might see a communication error message. The message appears because the engine stops working while the upgrade is in progress.
- After an upgrade, the Application Dependencies tab is available only after you restart the vSphere Web Client service on the vCenter Server.
Perform the uninstall process to remove the vCenter Infrastructure Navigator plug-in from the vCenter Server.

**Uninstall vCenter Infrastructure Navigator Plug-in**

The uninstall procedure removes the plug-in from the vCenter Server.

**Procedure**

1. Log in to vSphere Web Client.
2. From the inventory menu, click Infrastructure Navigator.
3. In the vCenter Infrastructure Navigator home page, click the Settings tab.
4. Click Uninstall.
5. At the confirmation prompt, click Yes.
   
   The uninstall process starts, and might take anywhere between 30 minutes and one hour, depending on number of virtual machines and applications running in your environment.

After successful completion of the uninstall procedure the message, Infrastructure Navigator is not installed on this vCenter Server.

If you are working with multiple vCenter servers, select the vCenter Server where Infrastructure Navigator is installed.

If you want to uninstall Infrastructure Navigator, you must restart the vSphere Web Client service to complete the uninstall process. You can then delete the virtual appliance.

is displayed in the vSphere Web Client. Also, the vCenter Infrastructure Navigator is cleaning up message is displayed in the vSphere Client.

**What to do next**

After you uninstall the vCenter Infrastructure Navigator plug-in, power off and delete the vCenter Infrastructure Navigator virtual machine from the vCenter Server. You need to restart the vSphere Web Client service to enable the installation of new vCenter Infrastructure Navigator plug-in in the future.
Troubleshooting vCenter Infrastructure Navigator

Troubleshooting vCenter Infrastructure Navigator provides information about the problems that you might encounter when using vCenter Infrastructure Navigator and provides possible solutions.

This chapter includes the following topics:

- “vCenter Certificate Error,” on page 37
- “vCenter Infrastructure Navigator Plug-In is not Visible in vSphere Web Client After an Upgrade,” on page 38
- “Error in Retrieving Information Might Occur,” on page 38
- “Incorrect Marking of a Virtual Machine as an External Machine,” on page 38
- “Deployment Failure After IP Address Change,” on page 39
- “Failure of the Virtual Appliance After DHCP Selection,” on page 39
- “VMware Tools Compatibility Error,” on page 39
- “vCenter Infrastructure Navigator Authentication Failure,” on page 39
- “Navigation Problem Between Objects,” on page 40
- “Navigation Error,” on page 40
- “Error Message in Recent Tasks List,” on page 40
- “vCenter Infrastructure Navigator Plug-in Removal Failure,” on page 41

vCenter Certificate Error

If you try to manually replace the certificate on the vCenter Server, vCenter Infrastructure Navigator cannot load the new certificate thumbprint.

**Problem**

If you delete the `/opt/vmware/etc/vami/ovfEnv.xml` file, the new file created at restart contains the old certificate’s thumbprint.

**Solution**

1. Select the vCenter Infrastructure Navigator virtual machine and verify that it is powered off.
2. Right-click the selected virtual machine and select **Edit Settings**.
3. Select the **vServices** tab.
4. Right-click **vCenter Extension vService Dependency** and click **Edit**.
5. Select **No Provider** from the **Provider** drop-down menu.
Click OK and click OK again.

Repeat Step 2 through Step 6, selecting vCenter Extension vService from the Provider drop-down menu in Step 5. When you power on the virtual machine next time, its OVF environment is updated with the new vCenter certificate thumbprint.

**vCenter Infrastructure Navigator Plug-In is not Visible in vSphere Web Client After an Upgrade**

After you have upgraded to a new vCenter Infrastructure Navigator build, the plug-in does not appear in vSphere Web Client.

**Problem**

After you have upgraded to a new vCenter Infrastructure Navigator build and log in to the vSphere Web Client, the plug-in does not appear in vSphere Web Client.

**Solution**

1. Restart the vSphere Web Client service.
2. Wait for five minutes and then log in again into the vSphere Web Client.

The plug-in is now visible.

**Error in Retrieving Information Might Occur**

If you restart the vCenter Infrastructure Navigator virtual machine or the engine services, an error message is displayed.

**Problem**

If vCenter Infrastructure Navigator cannot map services that are running on a selected vCenter entity, instead of the total number of services installed, an Error retrieving information from Infrastructure Navigator message is displayed.

**Solution**

Wait for few minutes and if the problem persists, restart the vCenter Infrastructure Navigator virtual appliance.

**Incorrect Marking of a Virtual Machine as an External Machine**

vCenter Infrastructure Navigator might incorrectly mark a virtual machine as an external machine.

**Problem**

vCenter Infrastructure Navigator can incorrectly mark a virtual machine as an external machine under the following conditions:

- A monitored virtual machine is configured with hardware version 4.
- Multiple IPv4 addresses are configured on the virtual machine.
- vCenter displays only one IP address for the virtual machine with hardware version 4, but according to vCenter Infrastructure Navigator, the IP address might be different. This issue does not occur with newer hardware versions, for example, hardware version 7 and 8.

**Solution**

If your virtual machine is located on an ESX 4.x or higher host, right-click the powered-off virtual machine and select Upgrade Virtual Hardware.
Deployment Failure After IP Address Change

You cannot deploy the vCenter Infrastructure Navigator plug-in after you change the IP address of the vCenter Infrastructure Navigator virtual appliance.

Problem
If you change the IP address of the vCenter Infrastructure Navigator virtual appliance, the vCenter Infrastructure Navigator plug-in fails to deploy in the vSphere Web Client.

Solution
After the IP address change, restart the vCenter Infrastructure Navigator virtual appliance.

Failure of the Virtual Appliance After DHCP Selection

The vCenter Infrastructure Navigator virtual appliance does not work if you assign the IP address using DHCP.

Problem
During the deployment of vCenter Infrastructure Navigator virtual appliance, if you assign the IP address to the vCenter Infrastructure Navigator virtual appliance using DHCP, the virtual appliance does not work correctly.

Solution
Restart the vCenter Infrastructure Navigator virtual appliance and the vSphere Web Client.

VMware Tools Compatibility Error

Virtual machine discovery might fail because of a VMware tools compatibility error.

Problem
If you attempt to discover virtual machines with a VMware Tools version that is lower than that which is compatible with ESX host version 3.5, the discovery might fail with the error message Unknown discovery error.

Solution
Update VMware tools.

vCenter Infrastructure Navigator Authentication Failure

The vCenter Infrastructure Navigator plug-in does not appear in the vSphere Web Client after you restart vCenter Server.

Problem
After you restart vCenter Server, the vCenter Server fails to authenticate the vCenter Infrastructure Navigator plug-in, so the Application Dependencies tab does not appear in vSphere Web Client.

Solution
Restart vCenter Infrastructure Navigator after you restart vCenter Server.
Navigation Problem Between Objects

A problem occurs when you navigate between objects in the left pane in the vSphere Web Client or when you navigate from the dependency map of one virtual machine to the dependency map of another virtual machine.

**Problem**

When you navigate between objects in the left pane in the vSphere Web Client, or when you navigate from the dependency map of one virtual machine to the dependency map of another virtual machine, the Loading... message might persist for a very long time in the user interface.

**Solution**

Navigate to a different object in the left pane or reload the vSphere Web Client.

Navigation Error

The vSphere Web Client displays an error message if you navigate from the VMs and Templates view to the vCenter Server root-level view.

**Problem**

In the vSphere Web Client, if you select the VMs and Templates view and navigate first to its folder level, then the data center level, and finally to the vCenter Server root level, the Application Dependencies tab displays the This list is empty error message.

**Solution**

Refresh the vSphere Web Client page or navigate by using a different sequence to reach the vCenter Server root level.

Error Message in Recent Tasks List

If you log in to a non-English version of the vSphere Client, an error message might appear in the Recent Task list.

**Problem**

After you deploy vCenter Infrastructure Navigator on a non-English version of the vSphere Web Client, the Recent Task list might display a label not found error message. This error message also appears in the Task Console of the vSphere Web Client.

**Cause**

This issue is caused by a VPX i18nfilter limitation on the language fallback mechanism.
Solution

For vCenter Server on a Windows machine:

a Create a dummy locale folder under the directory `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale` in the vCenter Server. For example, `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\de`, `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\fr`, `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\ja`, `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\zh_CN`, or `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\ko`.

b Copy all the English resource files under `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\en` to the locale folders that you have created. vCenter Server loads the strings correctly by using the dummy resource files.

For vCenter Server on a Linux machine:


b Copy all the English resource files under `/usr/lib/vmware-vpx/extensions/com.vmware.vadm/locale/en` to the locale folder that you have created. vCenter Server loads the strings correctly by using the dummy resource files.

vCenter Infrastructure Navigator Plug-in Removal Failure

After you uninstall the vCenter Infrastructure Navigator plug-in, the plug-in is not removed from the vSphere Web Client.

Problem

If you try to uninstall the vCenter Infrastructure Navigator plug-in from the vSphere Web Client, the plug-in is not removed. If you log in after the uninstall process, the Navigator tabs and portlets are present in the vSphere Web Client.

Solution

Restart the vSphere Web Client service.
Index

A
- Active Discovery 8, 9
- administrator privileges 23
- administrator role 21
- application discover process 19
- application discovery start 25
- stop 25
- application services 8
- apply license 20
- applying license 20
- architecture 8
- assigning privileges 21
- authentication
  - using vCenter Single Sign-On 18
  - vCenter Server 18
- authentication failure 39

B
- benefits 8

C
- certificate error 37
- certificates 30
- child objects 21
- configurations 9
- Console interaction 23

D
- data protection 29
- Database component 9
- deployment process 15, 16
- DHCP post requisite 39

E
- ESX/ESXi requirements 13
- evaluation license 21

F
- firewall 29
- functionality 7

G
- graphical user interface 9

Guest operating system management by VIX API 23

I
- incorrect marking of a virtual machine 38
- initiating SRM 26
- installation process 16
- installing 11
- integration 7
- intended audience 5
- IP address change 39

K
- knowledge base version 24

L
- license, apply 20
- license key 20
- licensing 19, 20
- log files 28

M
- manage users
  - Active Directory domain 18
  - single sign-on 18
- minimal permission 23
- minimal privileges 23
- multiple vCenter Server instance 24

N
- navigation error 40
- navigation problem 40

O
- OVA format 15
- overview, vCenter Infrastructure Navigator 7

P
- permission for users 21
- plug-in 9
- plug-in removal failure 41
- plug-in upgrade 38
- port requirements 15
- preface 5
- privileges 21
- privileges to view data 22
product version 24
product support package 27

R
recent task list error 40
registration of vCenter Server 11
removing vCenter Infrastructure Navigator 35
requirements, virtual machine 13
root folder 22

S
security 29
select vCenter Server 24
sensitive files 30
sensitive data 29
Server component 9
server IP address 11
setting up the vCenter Infrastructure Navigator 19
single sign on 18
single sign on licensing 20
software requirements 14
SRM 7
suite licensing 19
supported suites 19

T
troubleshooting
certificate error 37
error retrieving information 38
VMware tools compatibility error 39
troubleshooting workaround 37

U
uninstall, vCenter Infrastructure Navigator 35
uninstall process 35
uninstall vCenter Infrastructure Navigator 35
update
center credentials 26
vCenter Site Recovery Manager credentials 27
upgrade
limitations 34
set upgrade policy 33
using Web console 34
vCenter Infrastructure Navigator 34
upgrade vCenter Infrastructure Navigator 33
upgrading knowledge base 27

V
valid credentials 19
valid license 19
vCenter, Single Sign-On 18
vCenter entity error 38
vcenter managed IP address 15
vCenter managed IP address 15, 16
vCenter Server, register 12
vCenter Server requirement 14
vCenter Server administrator privileges 11
vCenter Single Sign On 11
vCenter Site Recovery Manager integrating 26
update credentials 27
vCenter Site Recovery Manager Server, stop integration 26
view system information 24
virtual machine requirements 13
virtual appliance 8
virtual environment 8
virtual infrastructure 7, 8
VMware Lookup Service 11
VMware tools, compatibility error 39
vSphere Web Client 9
vSphere Web Client requirement 14